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What are Curves  
A	Curves	adjustment	in	any	image	editor	is	a	method	of	altering	the	tonal	values	
in	the	displayed	image.	The	interface	for	doing	this	will	look	slightly	different	in	
each	editor	but	the	basic	components	will	always	be	the	following:	

1. A	histogram	representing	the	distribution	of	brightness	levels	in	the	image.	
2. The	range	of	tones	in	the	starting	image.	Called	the	INPUT.	The	extreme	left	is	

black,	the	extreme	right	is	white.	
3. The	range	of	tones	in	the	adjusted	image.	Called	the	OUTPUT.	The	bottom	is	

black	and	the	top	is	white.	
4. The	“curve”	that	determines	how	tones	in	the	input	are	translated	to	tones	in	

the	output.	Before	adjustments	are	made	this	will	be	a	straight	line	-	so	the	
output	tones	are	the	same	as	the	input	tones.	

If	the	curve	(which	starts	as	a	straight	line	called	
the	baseline)	is	adjusted,	the	tones	in	the	input	
are	changed	to	tones	in	the	output	as	in	this	
example:	

The	input	tones	that	were	at	level	125	(on	a	
scale	of	0	to	255)	become	level	79	in	the	output	-	
they	are	darkened.	
In	this	example,	all	other	tones	(except	the	two	
extremes	of	0	and	255)	will	also	be	darkened.	
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There	are	various	ways	of	changing	the	shape	of	the	curve	to	change	the	tones	in	
the	image.	Most	methods	(see	later	details)	use	control	points	on	the	curve.	
Moving	a	control	point	up	will	lighten	the	corresponding	tones	in	the	output	and	
moving	it	down	will	darken	the	corresponding	tones	in	the	output.	
Control	points	can	be	removed	by	dragging	them	off	the	graph	or	by	selecting	the	
point	and	pressing	Delete,	or	by	Ctrl-Click	(windows)	or	Cmd-Click	(Mac)	on	the	
control	point.	

Creating a Curves Adjustment in 
Photoshop 
As	with	most	things	in	Photoshop,	there	are	several	different	ways	of	creating	a	
Curves	adjustment.	The	basic	options	are	to	create	the	Curves	adjustment	from	
the	menu	or	to	create	a	Curves	adjustment	layer.	Creating	a	Curves	adjustment	
layer	has	the	advantage	that	the	adjustment	can	be	easily	removed	or	changed	
later,	and	it	is	the	recommended	method.	However,	if	you	are	not	familiar	with	
what	Curves	adjustments	do	to	an	image	it	can	be	useful	to	experiment	by	
creating	the	adjustment	from	the	menu.	This	allows	you	to	see	almost	all	the	
available	options	at	the	same	time.	
If	you	open	an	image	in	Photoshop	and	select	Image>Adjustments>Curves	it	
will	bring	up	the	following	window:	
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The	downside	of	making	Curves	adjustments	in	this	way	is	that	they	directly	
charge	the	pixels	in	the	image	and	the	changes	cannot	be	reversed	after	you	close	
the	Curves	window	(unless	you	use	the	History	function).			However,	by	exploring	
the	various	options	in	this	window,	you	can	build	your	understanding	of	what	a	
Curves	adjustment	does	to	an	image	and	this	will	make	it	easy	for	you	to	make	
adjustments	with	the	more	versatile	approach	of	a	Curves	adjustment	layer.		
The	easiest	way	to	think	of	what	a	Curves	adjustment	does	is	that	it	takes	the	
tonal	values	of	the	pixels	in	the	image	(the	“input”	-	what	you	start	with)	and	
changes	them	to	new	tonal	values	(the	“output”-	the	adjusted	image	you	are	
seeing	on	the	screen).	The	changes	will	either	lighten	or	darken	the	pixels	in	
various	parts	of	the	image	depending	on	the	shape	of	the	“curve”.	
The	basic	things	to	understand	are	the	following:	

The	histogram	shows	how	the	tones	
in	the	image	a	distributed	before	you	
make	any	adjustments	-		from	the	
darkest	tones	on	the	left	to	the	
lightest	tones	on	the	right.	
The	curve	(which	starts	as	a	straight	
line)	provides	the	formula	that	
Photoshop	uses	to	translate	the	
tones	to	their	new	values.		
The	small	squares	on	the	curve	are	
adjustment/control	points	that	you	
can	click	on	and	move.	Clicking	
anywhere	on	the	curve	will	add	a	
new	adjustment	point.	
	

The	following	examples	illustrate	
some	basic	adjustments,	starting	with	
this	image	that	has	the	histogram	
shown	above:	
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Changing	the	dark	tones:	

In	this	example,	the	adjustment	point	(control	point)	at	the	extreme	left	(the	
darkest	pixels)	was	moved	up	-	this	instructed	Photoshop	to	make	the	darkest	
pixels	lighter.	The	control	point	at	the	other	end	of	the	curve	was	not	changed,	so	
the	lightest	pixels	remained	at	their	original	value.	All	the	pixels	in	between	the	
darkness	and	lightest	values	were	made	lighter,	with	the	effect	being	greater	at	
the	darker	end	of	the	scale	(where	the	difference	between	the	baseline	and	the	
new	curve	is	greatest).	

Changing	the	light	tones:	

In	this	example,	the	adjustment	point	at	the	extreme	right	(the	lightest	pixels)	
was	moved	down	-	this	instructed	Photoshop	to	make	the	lightest	pixels	darker.	
The	control	point	at	the	other	end	of	the	curve	was	not	changed,	so	the	darkest	
pixels	remained	at	their	original	value.	All	the	pixels	in	between	the	lightest	and	
darkest	values	were	made	darker,	with	the	effect	being	greater	at	the	lighter	end	
of	the	scale	(where	the	difference	between	the	baseline	and	the	new	curve	is	
greatest).	
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Changing	the	mid-tones:	

In	this	example,	placing	an	adjustment	point	near	the	centre	of	the	curve	and	
moving	it	up	lightened	all	tones	in	the	image	but	the	two	endpoints	(darkest	
pixels	and	lighter	pixels)	did	not	change.	

In	this	example,	placing	an	adjustment	point	at	the	centre	of	the	curve	and	
moving	it	down	darkened	all	tones	in	the	image	but	the	two	endpoints	(darkest	
pixels	and	lightest	pixels)	did	not	change.	
There	is	no	limit	to	the	number	of	adjustment/control	points	you	can	place	on	a	
curve	(just	click	on	the	curve	where	you	want	an	adjustment	point).	This	gives	
you	a	wide	range	of	possibilities	for	tonal	(and	colour)	adjustments.	One	of	the	
most	common	adjustments	to	make	with	Curves	is	the	so-called“S-curve”	that	is	
used	to	increase	contrast.	This	involves	adding	a	]ixed	adjustment	point	near	the	
centre	of	the	curve	and	then	two	other	points	-	one	to	darken	the	shadows	and	
one	to	lighten	the	highlights.	
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When	you	place	an	adjustment	point	on	the	curve,	the	input	and	output	values	at	
that	point	appear	below	the	curve:	

If	there	are	multiple	control	points	on	the	curve,	you	can	click	on	each	one	to	
select	it	and	see	the	input/output	values.	
When	a	point	is	selected,	you	can	change	the	input/output	values	(move	the	
point)	by	using	the	keyboard	arrows	-	the	left/right	arrows	change	the	input	
value,	and	the	up/down	arrows	change	the	output	value.	

Setting	the	black	and	white	points.	
At	either	end	of	the	scale	that	shows	the	input	tones,	there	are	two	triangles.	By	
clicking	and	dragging	the	left	(black)	triangle	you	can	set	a	new	black	point	for	
the	image	-	the	input	level	that	will	be	made	pure	black	in	the	output.	By	clicking	
and	dragging	the	right	(white)	triangle	you	can	set	a	new	white	point	for	the	
image	-	the	input	level	that	will	be	made	pure	white	in	the	output.			
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Adjusting	black	and	white	points	can	cause	clipping.	To	reveal	clipping	as	you	
adjust	the	black	and	white	points	you	can	do	one	of	the	following:	
a) Hold	down	Option	(Mac)	or	Alt	(Windows)	as	you	drag	the	triangle,	or	
b) Choose	“Show	Clipping	for	Black/White	Points”	from	the	curves	panel	that	

opens	when	you	create	a	Curves	adjustment	layer	(see	later	details).	
To	reinforce	these	basic	ideas	of	what	the	Curve	does,	it	is	worth	experimenting	
with	a	few	images	of	different	types	-	landscape,	portrait	and	so	on.	Then	it	is	
worth	exploring	some	of	the	other	options	in	the	Curves	adjustment	window	
(that	was	shown	on	page	2).	
In	the	Curves	adjustment	window,	the	PRESET	option	allows	you	to	quickly	apply	
a	pre-determined	curve	by	clicking	on	the	arrow	and	making	a	choice.	The	
‘Default’	is	simply	the	starting	point	of	a	straight	line.	

The	Curves	presets	in	Photoshop	2023.	

Presets	can	give	you	a	good	starting	point	for	
your	adjustment.	

The	‘cog’	next	to	where	the	preset	names	appear	
allows	you	to	import	other	presets	or	to	save	a	
preset	you	have	created.	

The	CHANNEL	option	allows	you	to	display	the	
composite	RGB	histogram	(the	default)	or	the	histograms	
for	the	individual	Red,	Green	and	Blue	channels.	Selecting	a	
speci]ic	channel	can	be	useful	when	you	want	to	alter	particular	colours	in	the	
image.	This	is	explained	in	detail	in	a	later	section.	
This	setting	determines	whether	the	histogram	will	show	
brightness	levels	(which	you	normally	want	it	to	show)	or	
pigment	levels	(which	can	be	useful	for	some	forms	of	
printing).	
	
These	icons	allow	you	to	add	adjustment	points	to	the	curve	(the	
normal	way	you	will	use	it)	or	to	draw	a	curve	“freehand”	(which	is	
rarely	useful	for	photographic	images).	If	you	select	the	freehand	
option,	the	“Smooth”	button	becomes	active	and	clicking	on	it	will	smooth	the	
curve	you	drew	freehand.	[Smoothing	is	done	differently	if	you	create	a	Curves	
adjustment	layer	-	see	Page	10.]	
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If	you	click	on	this	icon	the	mouse	pointer	will	change	to	an	eyedropper.	If	
you	then	click	anywhere	on	your	image,	it	will	place	an	adjustment	point	
at	the	corresponding	point	on	the	curve.	When	this	option	is	active,	right-
clicking	anywhere	on	the	image	brings	up	this	dialogue:	

This	allows	you	to	vary	the	area	beneath	the	mouse	pointer	
that	is	being	sampled	to	determine	the	brightness	level.	It	is	
usually	best	to	select	a	value	of	at	least	5X5	pixels	or	you	may	
get	unexpected	results.	

The	three	eyedroppers	enable	you	to	set	the	black	point	(darkest	pixels),	the	mid-
grey	point	and	the	white	point	(lightest	pixels)	in	the	image.	
When	you	do	this,	you	will	see	that	three	additional	lines	have	
been	added	to	the	curve,	one	for	each	of	the	Red,	Green	and	Blue	
channels	to	show	how	they	have	changed.	
The	AUTO	button	can	be	a	useful	starting	point	for	Curves	adjustment	as	it	
applies	an	automatic	adjustment	for	colours	and	contrast.	You	can	set	various	
options	for	this	auto	adjustment	and	it	can	be	worth	experimenting	to	see	which	
option	gives	you	the	best	starting	point	for	your	adjustments.	
The	PREVIEW	option	lets	you	review	the	adjustments	in	real	
time	(if	the	box	is	ticked).	
	
If	you	want	to	undo	the	adjustments	you	have	made	in	the	
Curves	dialogue	window,	hold	down	the	Alt	(Mac)	or	
Option(Windows)	key	and	the	Cancel	button	will	change	to	
Reset.	
The	remaining	options	in	the	Curves	dialogue	window	are	
all	best	left	turned	on	as	they	in]luence	what	you	see	in	
the	adjustment	area.	

If	you	decide	that	making	Curves	adjustments	from	the	menu	is	your	preference,	
duplicate	your	background	layer	and	make	the	Curves	adjustment	on	that	layer.		
You	can	then	delete	that	layer	and	start	again	if	necessary.	
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Using a Curves Adjustment Layer 
If	you	make	Curves	adjustments	by	opening	the	Curves	dialogue	window	from	the	
menu,	when	you	click	OK	the	adjustments	are	‘locked	in’.	If	you	open	the	Curves	
dialogue	again	you	cannot	undo	the	previous	changes.		
To	give	yourself	the	option	of	changing	the	Curves	adjustment,	you	need	to	create	
a	Curves	adjustment	layer.	You	can	do	this	in	several	ways:	
1. From	the	menu	select	Layer>New	Adjustment	Layer>Curves.	This	opens	a	

window	in	which	you	can	name	the	layer	and	set	parameters	such	as	the	
opacity	Start	at	100%)	and	the	layer	blend	mode	(leave	at	“Normal”).	

2. At	the	bottom	of	the	layers	palette	click	on	the	icon	for	”Create	new	]ill	or	
adjustment	layer”	and	select	“Curves”.	

	
Either	method	will	create	a	
Curves	adjustment	layer	and	
automatically	add	a	white	layer	
mask.	

The	second	method	does	not	
give	you	the	“New	Layer”	options	
shown	above.	However,	you	can	
change	those	variables	after	the	
layer	is	created.	
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Creating	the	Curves	adjustment	layer	
also	opens	the	properties	panel	that	
displays	options	similar	to	those	
available	in	the	Curves	dialogue	window	
that	was	described	earlier.	
If	you	add	an	adjustment/control	point	
and	drag	to	move	the	curve,	the	
information	below	the	histogram	shows	
how	the	‘input’	(original)	tonal	value	at	
that	point	has	been	changed	to	the	
‘output’	value.	
The	icons	at	the	bottom	of	this	window	
provide	some	useful	options:	

	This	deletes	the	adjustment	layer.	
This	toggles	the	layer	visibility	on	
and	off.	
This	resets	the	adjustment	to	the	
default	(starting)	position.	
This	allows	you	to	view	what	the	
adjusted	image	looked	like	before	
the	last	adjustment	you	made	to	the	curve.	
In	its	default	position,	this	allows	the	Curves	adjustment	to	affect	all	the	
layers	below	it.	If	you	click	on	it,	the	icon	changes	to	this:			
Now	the	Curves	adjustment	layer	is	‘clipped’	to	the	layer	below	-	it	affects	
only	that	layer	and	not	any	other	layers.		The	clipping	is	indicated	in	the	
layers	palette	like	this:	

The	icons	down	the	left	side	of	the	Curves	panel	have	the	same	functions	as	the	
corresponding	icons	in	the	Curves	window	that	opens	when	you	select	Curves	
from	the	menu.	They	enable	you	to	select	the	targeted	adjustment	tool,	
eyedroppers	for	setting	the	black	point,	mid-point	and	white	point,	and	the	
option	of	adding	control	points	or	drawing	a	freehand	curve.		
There	is	one	additional	icon	that	allows	you	to	smooth	the	curve	if	you	have	
drawn	it	freehand.	
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Another	useful	feature	available	in	the	properties	panel	when	
the	Curves	panel	is	displayed	is	the	icon	that	allows	you	to	view	
the	layer	mask	and	its	properties.	[Refer	to	the	separate	tutorial	
on	layers	and	masks	and	information	about	mask	properties.]	

This	icon	in	the	top	right	of	the	Curves	panel	provides	a	range	of	options.	

	“Auto-Select	Parameter”	-	does	not	do	anything	in	the	Curves	panel.	In	other	
panels	(such	as	Levels)	it	highlights	the	]irst	box	where	a	value	can	be	typed.	
“Auto-Select	Targeted	Adjustment	Tool”	has	the	same	effect	as	clicking	on	
this	icon.	It	turns	on	the	feature	that	places	a	control	point	on	the	curve	to	
correspond	with	the	part	of	the	image	over	which	the	mouse	is	hovering.	
“Save	Curves	Preset”	allows	you	to	create	a	preset	from	whatever	Curves	
adjustment	you	have	made.	That	saved	preset	will	appear	on	the	list	of	presets	
that	is	displayed	when	you	click	the	arrow	next	to	the	name	of	the	current	preset.	
“Load	Curves	Preset”	allows	you	to	add	a	new	preset	(created	by	someone	else	
and	downloaded	from	the	Internet).	Once	loaded,	it	will	appear	on	the	dropdown	
list	of	presets.	
Selecting	“Curves	Display	Options”	provides	
the	same	options	that	are	available	when	
you	select	Curves	from	the	menu	(refer	to	
page	2).	
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“Show	Clipping	for	Black/White	Points”	will	reveal	clipping	of	the	whites	or	
blacks	when	you	click	on	the	triangles	below	the	‘input’	scale.	
“Auto	Options”	allows	you	to	set	up	and	
apply	various	automatic	colour	correction	
options.			
The	settings	you	create	here	are	applied	
when	you	click	on	the	“Auto”	button	
above	where	the	curve	is	displayed:	

This	can	be	a	useful	starting	point	for	
colour	corrections.	

Whether	you	apply	a	Curves	adjustment	with	a	Curves	Adjustment	Layer	
(recommended)	or	from	the	menu,	it	provides	a	very	versatile	way	to	adjust	tones	
in	an	image.	It	can	also	be	used	to	make	colour	adjustments	and	to	match	colours	
from	one	image	to	another.	These	techniques	are	explored	in	another	tutorial.	
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Curves in Adobe Camera Raw 
A	Tone	Curve	can	be	used	to	adjust	an	image	in	Adobe	Camera	Raw	using	the	
same	basic	principles	that	were	discussed	above	(but	with	more	limited	options).		
The	Tone	Curve	can	be	adjusted	in	two	different	ways,	selected	from	the	icons	
above	where	the	histogram	is	displayed.	The	option	shown	here	(selected	with	
the	icon	on	the	extreme	left)	is	referred	to	as	the	parametric	curve.		

In	the	parametric	mode,	the	curve	can	be	adjusted	in	two	ways:	
a) By	moving	the	sliders	below	the	window,	or	
b) By	hovering	the	mouse	over	the	curve,	clicking	and	dragging.	(This	will	

automatically	move	the	positions	of	the	relevant	sliders.)	
The	tonal	values	that	are	treated	as	Highlights,	Lights,	Darks,	and	Shadows	are	
determined	by	the	positions	of	the	control	points	below	the	histogram:	

The	extent	of	the	adjustments	that	can	be	made	to	each	region	of	the	curve	is	
limited	by	the	extremes	of	the	slider	positions.	
The	alternative	to	the	parametric	curve	
is	called	a	point	curve	adjustment.	It	is	
selected	by	clicking	on	the	second	icon	
from	the	left:	
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This	opens	a	slightly	different	panel:	

This	is	very	similar	to	the	Curves	adjustment	in	Photoshop.	You	can	add	as	many	
adjustment/control	points	as	you	like.	The	last	added	adjustment	point	is	shown	
as	a	solid	dot	on	the	curve	and	the	input/output	values	at	that	point	are	shown	
below	the	curve.	
In	the	default	Point	mode,	any	adjustment	will	change	the	tonal	values	in	the	
composite	image.	However,	there	are	three	other	options.	You	can	choose	to	
adjust	only	the	Red,	Green	or	Blue	channels	by	selecting	the	appropriate	icon.	If,	
for	example,	you	select	the	Red	option	the	display	changes	to	this:	
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If	you	select	a	point	on	the	curve	and	drag	it	up,	this	will	increase	the	brightness	
of	the	reds	in	the	image.	If	you	drag	down,	this	will	reduce	the	intensity	of	the	
reds	and	increase	the	intensity	of	the	cyans	in	the	image.	
If	you	elect	the	Green	option,	dragging	up	on	the	curve	increases	the	intensity	of	
greens	and	dragging	down	increases	the	intensity	of	magentas.	
If	you	select	the	Blue	option,	dragging	up	on	the	curve	increases	the	intensity	of	
the	blues	and	dragging	down	increases	the	intensity	of	the	yellows.	
An	additional	icon	that	is	available	in	all	four	versions	of	the	point	curve	
adjustment	(Composite,	Red,	Green	and	Blue)	is	the	Target	Adjustment	Tool	(top	
right	of	the	Point	Curve	adjustment	panel).	

	If	you	select	this	tool	and	then	click	anywhere	on	the	image,	it	places	an	
adjustment	point	on	the	curve.	Dragging	the	mouse	left	or	right	will	
move	the	curve	down	or	up	at	that	point.	

If	you	want	to	undo	the	Curves	adjustments	and	reset	to	the	unadjusted	image,	
hold	down	the	Alt	key	(Mac)	or	Option	key	(Windows)	and	the	“Curve”	label	will	
change	to	“Reset	Curve”	-	clicking	on	it	resets	the	curve.	

	
		
When	you	have	either	the	Point	Curve	or	Parametric	Curve	panels	
open,	this	icon	at	the	top	right	allows	you	to	temporarily	turn	off	the	
adjustments	and	see	the	original	image:	

If	you	make	an	adjustment	in	the	Parametric	Curve	view	and	then	select	the	Point	
Curve	view,	the	image	you	are	viewing	will	not	change	(the	adjustments	will	still	
take	effect).	However,	the	Curve	adjustments	that	you	applied	in	the	Parametric	
view	do	not	show	on	the	Point	Curve	view.		The	same	thing	happens	if	you	make	
an	adjustment	in	the	Point	Curve	view	and	then	swap	to	the	Parametric	Curve	
view.	
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Curves in Lightroom 
In	the	Lightroom	Develop	module,	Curves	adjustments	are	made	in	a	similar	way	
to	Adobe	Camera	Raw	-	there	is	a	Point	option	and	a	Parametric	option.	

	
In	either	mode,	targeted	adjustments	can	be	made	by	selecting	this	
icon:		

From	Version	12.4	of	Lightroom	Classic	(June	2023)	there	is	an	additional	useful	
feature.	When	a	Point	Curve	is	adjusted,	it	obviously	alters	the	contrast	in	the	
image	-	but	it	can	also	increase	the	saturation.	To	counter	that	effect,	a	“Re]ine	
Saturation”	slider	now	appears	below	the	curve:	

	Moving	the	slider	to	the	left	will	reduce	the	saturation	that	was	introduced	by	the	
Curve	adjustment.	
At	the	time	of	writing	this	tutorial,		the	Re]ine	Saturation	slider	was	not	available	
when	the	Paramedic	Curve	is	used,	nor	was	it	available	in	Adobe	Camera	Raw.	
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Conclusion 
The	Curves	adjustment	is	one	of	the	most	versatile	ways	of	altering	the	
distribution	of	tones	in	an	image.	Making	the	adjustment	in	Photoshop	(on	an	
adjustment	layer)	is	the	most	versatile	approach	because	it	can	be	changed	at	any	
time	if	the	]ile	is	saved	in	PSD	or	TIFF	format.	

If you want to suggest any improvements to these notes please send me an email.

Roy Killen
14th June 2023
roykillen@mac.com 
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